




 

 

PENDAHULUAN 

MENGENAL SOLIDWORKS 

SolidWorks adalah software desain yang digunakan untuk memodelkan dan 

menciptakan gambar dalam 2D dan gambar 3D dalam tiap part (bagian) ataupun 

assembly (rakitan). 

 

Gambar 1.1 Halaman Depan Solidworks 

 

Apa Itu Solidworks? 

 
SOLIDWORKS adalah salah satu CAD software yang dibuat oleh DASSAULT 

SYSTEMES digunakan untuk merancang part permesinan atau susunan part 

permesinan yang berupa assembling dengan tampilan 3D untuk merepresentasikan 

part sebelum real part nya dibuat atau tampilan 2D (drawing) untuk gambar proses 

permesinan. 

Sejarah Solidworks 

 
SolidWorks diperkenalkan pada tahun 1995 sebagai pesaing untuk program CAD 

seperti Pro / ENGINEER, NX Siemens, I-Deas, Unigraphics, Autodesk Inventor, 

Autodeks AutoCAD dan CATIA, dengan harga yang lebih murah. SolidWorks 

Corporation didirikan pada tahun 1993 oleh Jon Hirschtick, dengan merekrut tim 

insinyur untuk membangun sebuah perusahaan yang mengembangkan perangkat 

lunak CAD 3D, dengan kantor pusatnya di Concord, Massachusetts, dan merilis 

produk pertama, SolidWorks 95, pada tahun 1995. 
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Pada tahun 1997 Dassault Systèmes, yang terkenal dengan CATIA CAD software, 

mengakuisisi perusahaan dan sekarang ini memiliki 100% dari saham SolidWorks. 

SolidWorks dipimpin oleh John McEleney dari tahun 2001 hingga Juli 2007, dan 

sekarang dipimpin oleh Jeff Ray. 

Mengenal Interface Solidworks 

 
Seperti aplikasi lain untuk menampilkan pekerjaan Solidworks juga menggunakan 

Windows. Windows pada Solidworks secara garis besar terbagi atas dua panel 

utama. Satu panel yang menampilkan non-graphical data dan panel yang lain 

menampilkan informasi dan mempresentasikan dari part, assembly, dan drawing. 

 
Gambar1.2 Interface Solidworks 
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Mengenal Jenis Jenis Dari Solidworks Document 

 

 

A.  Part Merupakan dokumen SolidWorks untuk membuat 1 bagian 

gambar dalam 3 dimensi. 

B.   Assembly merupakan dokumen SolidWorks untuk merakit bagian- 

bagian dan dapat pula untuk membuat bagian (part) dalam assembly. 

C.    Drawing merupakan representasi dalam 2 dimensi pada lembar 

dokumen (kertas) dari part maupun assembly. 

 
Mengenal Tools Solidworks 2014 

 
Tampilan Toolbox pada Solidworks terletak pada bagian atas layar. Toolbox berisi 

perangkat perangkat bantu yang digunakan selama merancang (mendesain). Berikut 

ini penjelasan dari beberapa tools penting yang umum digunakan dalam merancang. 

 

Gambar 1.3 Tools Tampilan Ruang Kerja. 

 

A. Zooming Tools 
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B. View Orientation Tools 

C. Display Style Tools 
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D. Sketcth Tools 
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E. Feature Tools 
 

Nama Tools Fungsi 

Extrude Boss  

 
Untuk membuat bentuk solid dari sketsa yang telah dibuat 

Revolved Boss  

Membuat bentuk solid dengan cara diputar terhadap suatu 

 
sumbu 

Sweap Boss  

 

Membuat bentuk solid dengan mengikuti sebuah alur 

Lofted Boss  

 

Membuat bentuk solid antara dua buah permukaan sketsa 

Extrude Cut  

 

Memotong bentuk solid yang telah dibuat 

Hole wizard  

 

Untuk membuat lubang pada bentuk solid yang ada 

Revolved cut  

Memotong bentuk solid dengan cara memutar terhadap 

 
suatu sumbu 

Sweapt Cut  

 
Memotong bentuk solid dengan mengikuti sebuah alur 

Lofted Cut  

 

Memotong bentuk solid antara dua permukaan sketsa 

Fillet  

Membulatkan bagian pinggir dari bentuk solid dengan 

 
radius tertentu 

Linier Pattern  

 

Mengulang suatu bentuk solid berdasarkan array linier 

Rib  
Membuat Rib / penguat dari suatu struktur solid 

Draft  

 
Memiringkan permukaan dari suatu bentuk solid 

Shell  

 

Membuat rongga / cangkang dari suatu bentuk solid 

Wrap  

 

Menutup kontur sketsa diatas permukaan solid 
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Nama Tools Fungsi 

Dome  

 
Membuat satu atau lebih kubah sebagai bentuk solid 

mirror  

Menggandakan bentuk solid dengan prinsip cermin, harus 

 
ada sebuah bidang yang bertindak sebagai cermin 

 

 

Belajar Membuat dan Mengenali bentuk Sketsa (Sketch) 

 
A. Mengenal jenis-jenis plane 

a. Front Plane 

b. Top Plane 

c. Right Plane 
 
 

 

Gambar1.5 Pandangan Isometris suatu Part 

 

B. Sketch 
 

Gambar1.6 Kubus Sederhana (Cube) 
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Langkah-langkah pengerjaan: 

1. Klik New ( ) (File > New), klik Part (  ), OK. 

2. Klik Pada Front Plane, lalu klik Sketch untuk memulai Sketch. 
 

3. Klik Rectangle ( ), lalu buat segiempat dengan ukuran sembarang. 
 

4. Klik Smart Dimension ( ), lalu klik garis benda beri ukuran sisi atas 

dan sisi samping dengan ukuran 30 mm. Lalu tekan tombol Enter atau klik 

OK. 
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5. Setelah itu pilih menu toolbar yaitu Feature ,lalu klik Extrude Boss/ Base. 
 

Setelah itu pada bagian panel Extrude masukkan nilai Depth sebesar 30 mm, 

lalu klik Ok. 

 

6. Kubus Sederhana dengan ukuran 30 x 30 x 30 mm telah selesai. 
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Modul Prtaktikum Gambar Teknik 

Teknik Industri, Universitas Ahmad Dahlan 10 

 

 

LATIHAN 

 
1. Menggunakan Front plane 

 

Kemudian di Extrude dengan Feature Extrude Boss/Base dengan depth 10 

mm. 

 

2. Menggunakan Right Plane dan Ketebalan Gambar sebesar 12 mm. 
 



 

 

3. Menggunakan Front Plane dan Ketebalan Gambar sebesar 100 mm. 
 

4. Menggunakan Top Plane dan Ketebalan Gambar sebesar 25 mm. 
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MEMBUAT GAMBAR TEKNIK DAN KEPALA GAMBAR 

 
Pendahuluan 

Setiap perusahaan atau institusi yang menggunakan gambar teknik / technical 

drawing, pasti mempunyai format kepala gambar standar. Untuk membuat kepala 

gambar, kita bisa meng customize Drawing Sheet Format di SolidWorks. 

Tutorial ini akan menjelaskan cara membuat kepala gambar di SolidWorks 

 
1. Membuka sebuah gambar baru 

 Buka SolidWorks > klik New > pilih drawing > klik OK 

 Pilih ukuran standar kertas, misal A4 landscape > klik OK 

 

 

 akan muncul sebuah gambar baru di graphic area  &  sebuah  Model  

View property manager. 
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2. Edit Sheet Format 

 Langkah selanjutnya adalah mengubah Sheet Format, karena kita tidak 

akan bekerja di sheet format, sehingga kita tidak memasukkan sebuah model 

dahulu kedalamnya. 

 Kita akan keluar dari property manager > klik cancel di property manager. 

 Klik kanan di manapun di dalam Drawing Sheet > pilih Edit Sheet Format. 

 Jika kita ingin merubah salah satu text di dalam Sheet Format, seumpama 

kita akan mengganti text Revision dengan Revisi. 

 Di dalam tittle block, klik 2x text Revision > text akan muncul di dalam Edit 

Box > ganti text dengan Revisi > klik di luar area text untuk menyimpan 

perubahan. 

 Klik text sekali lagi > di dalam property manager klik Font > ganti jenis 

Font dan ukurannya. 
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 Klik sekali lagi di luar text area untuk menyimpan perubahan. 

 untuk menambah text di dalam Sheet Format > klik Insert > Annotation 

> klik Note ( ) > muncul text box > tempatkan text box ke dalam area 

yang diinginkan > seumpama kita akan membuat text nama perusahaan. 

 Tulis nama perusahaan di dalam text box > atur jenis font dan ukuran. 
 

 

 Klik di luar text box untuk meyimpan perubahan. 

 Untuk membuat garis baru > klik Sketch > klik Line ( ) 
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 Untuk menghapus text atau garis, klik text atau garis yang di maksud > klik 

kanan > pilih Delete. 

 Untuk memindahkan text atau garis, klik text atau garis yang di maksud > 

klik kanan > Move the Entities. 

 Untuk menyimpan sheet format yang baru tanpa menimpal sheet format 

standar > klik File Save sheet format > arahkan ke folder tempat 

menyimpan sheet format yang baru > isikan nama file > klik Save. 

 

 

 Setelah semua perubahan disimpan > kita akan keluar dari Edit Sheet 

Format > klik kanan di manapun di Drawing Sheet > pilih Edit Sheet. 
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 Tampilan sesudah keluar dari Edit Sheet Format. 
 

 keluar dari sheet format. 

 
3. Membuat gambar dengan sheet format yang baru 

 Untuk memulai gambar dengan kepala gambar baru > klik Open > arahkan 

ke folder tempat menyimpan Sheet Format yang baru > klik All File. 
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 Pilih file yang telah kita buat tadi > teknik industri.SLDDRT file. 

 Klik Insert > Drawing View > Model. 

 

 

 Akan keluar Model View property manager > klik Browse > pilih part yang 

hendak kita buat gambarnya > klik Open. (Model yang kita gunakan adalah 

part dengan Feature Rib yang telah kita buat sebelumnya). 
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 Atur penempatan part di dalam kertas gambar (Graphic Area) 
 

 

 Selesai. 
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BAB I 

FEATURE EXTRUDE DAN FEATURE RIB 
 
 

 

Pada Bab I kita akan mencoba membuat bentuk solid seperti gambar diatas. 

Dalam membuat gambar tersebut kita menggunakan serta mempelajari 3 features 

yang sederhana ,yaitu : 

a) Extruded Boss 

b) Extruded Cut 

c) Fillet 

Berikut merupakan langkah-langkah pengerjaannya: 

1. Klik New ( File > New ), kemudian klik Part  , dan klik OK. 

2. Klik kiri pada Top Plane lalu klik sketch. 
 

3. Buat sebuah Rectangle atau persegi yang ada di dalam kotak dialog skecth 

dengan ukuran sesuai gambar : 
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4. Setelah sketch sesuai dengan gambar kemudian klik Features, dan klik 

Extrude Boss seperti gambar dibawah. 
 

Kemudian pada bagian panel extruded masukkan depth dengan angka 10 

mm, lalu tekan enter atau Ok. 

 

5. Setelah selesai kita buat sketch baru dengan cara kita klik kiri atau kanan 

sisi depan gambar lalu pilih sketch. 

 

Setelah itu kita buat gambar seperti contoh berikut ini ; 
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Setelah sketch sesuai dengan contoh diatas, kemudian kita Extrude dengan 

ketebalan atau depth sebesar 10 mm. 

6. Setelah itu kita akan membuat lubang pada sisi depan part. Cara membuat 

sketch s a m a seperti pada point 5, dan kemudian kita buat sebuah sketch 

lingkaran dengan diameter 10 mm. 

 

Kemudian masuk ke Features dan klik Extrude cut dengan kedalaman atau 

Depth sebesar 10 mm. 

 

7. Kita buat sketch baru pada sisi atas gambar dengan cara sama seperti membuat 

sketch pada bagian samping sebelumnya. Kemudian buat skecth dua buah 

lingkaran seperti gambar dibawah ini. 

  

Lalu masuk Features dan klik Extrude cut dengan kedalaman atau Depth 

sebesar 10 mm. 
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8. Kita buat sketch pada bagian depan part dengan cara sama seperti membuat 

sketch pada bagian samping sebelumnya. Buat sketch seperti pada gambar 

dibawah ini dan kemudian di Extrude Cut sebesar 40 mm 

 

9. Klik Feature Fillet lalu pada angka radius kita ubah dengan radius 6 mm 

dan klik pada bagian seperti gambar contoh berikut : 

 

Lalu kembali masuk Feature Fillet dan pada angka radius kita ubah dengan 

radius 3 mm dan klik pada bagian seperti gambar contoh berikut: 
 

10. Setelah selesai hasilnya akan seperti gambar di bawah ini , dan jangan lupa 

untuk menyimpannya karena akan di gunakan pada Bab berikutnya. 
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FEATURE RIB 
 

 

Pola pembuatan komponen (part) di dalam SolidWorks. 

Secara umum, pembuatan part/komponen di dalam SolidWorks melalui 

tahapan sebagai berikut: 

1. Menentukan Plane 

2. Membuat Sketch 

3. Menentukan Dimension 

4. Keluar (exit) dari sketch 

5. Memilih Feature 

6. Menentukan nilai parameter di dalam Feature Manager Design Tree 

 
Fitur Rib adalah fitur untuk membuat sebuah sirip tipis yang menempel 

pada permukaan pejal. Pada umumnya rib digunakan untuk memperkuat atau 

mencegah lengkungan pada design kita. Fitur Rib memerlukan 3 hal: Sketch, arah 

rib dan ketebalan rib. Sketch untuk rib harus mempunyai 3 syarat: kurva terbuka 

tunggal (bukan kurva tertutup), sketch tidak saling memotong & tidak 

bersebelahan, ujung sketch menempel pada permukaan “parent feature” & 

membentuk daerah tertutup. 
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Ada 2 tipe fitur Rib: Straight dan Rotational. Fitur Rib ini dapat di akses 

dengan 2 cara: klik ikon Rib di features toolbar   atau pilih Insert > features 

> Rib di pull-down menu.  Dalam memilih Sketch yang akan dibuat rib, kita dapat 

memilih sketch yang telah kita buat sebelumnya lalu masuk ke tool Rib atau 

sebaliknya, kita masuk ke tool Rib dahulu baru membuat atau memilih sketch. 

Di dalam tutorial ini kita akan membuat part seperti pada gambar di atas, 

pembuatan part tersebut terdiri dari feature Extruded Boss/Base, Shell, Rib, dan 

Circular pattern. 

1. Membuat kotak dengan Etruded Boss/Base 

 Buka SolidWork >klik New >pilih Part >klik Ok

 Pilih Top Plane > klik sketch > pilih view Normal To

 Klik Rectangle, buat kotak dengan ukuran  30  x  30  mm, perhatikan  

letak titik Origin > sesuaikan ukuran dengan Smart Dimension.

 

 

 Exit  sketch  > klik  features   > pilih   Exture   Boss/Base > masukan 

nilai Depth 10 mm dalam Extruded property manager.
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 Klik OK

 

2. Membuat Shell pada kotak 

 

 Klik shell pada barisan toolbar features >masukan nilai 2 mm pada 

thinkness di shell property manager > pilih face to Remove pada bagian atas 

kotak.

 

 klik OK
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3. Membuat Rib 

 

 Klik Sketch > pilih Front Plane > klik view Normal To.

 Klik Line > klik Hidden Line Visible > titik 1 koordinat (13,10).

 Titik 2 dengan koordinat (-7,2)

 

 Exit Sketch > klik Features > pilih Rib > akan keluar Rib Property 

Manager > masukkan nilai Rib Thickness 2 mm > klik OK
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4. Membuat Circular Patern 

 membuat Axis of Revolution

 klik Front Plane > klik Sketch > pilih view Normal To > klik Line, buat 

garis vertical dari titik Origin, seperti gambar.

  

 Kemudian Exit Sketch dan buat Axis dengan klik Insert > pilih Reference 

Geometry > klik Axis > pilih garis yang telah di buat pada Sketch 

sebelumnya.

 Klik Features > pilih Circular Pattern.

 Didalam property manager > pilih Pattern Axis : Axis 1 > klik Equal 

Spacing > masukan nilai 4 dalam Number of Instances > masukan features 

Rib yang sebelumnya sudah kita buat dalam kotak features to paterns > klik 

OK.
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5. Part yang sudah selesai seperti gambar dibawah ini. 

Program Pengabdian Kepada Masyarakat 
Universitas Ahmad Dahlan, 2022                                                                    28 



 

 

BAB II 

FEATURE REVOLVE 

 

Bab ini akan menjelaskan penggunaan feature revolve secara umum. Langkah 

awalnya adalah membuat sketch yang akan digunakan sebagai profile (gambaran 

secara geometris). 

1. Membuat sketch untuk profile yang akan menggunakan feature revolve: 

a. Buka SolidWorks, klik New. 

b. Pilih Part, klik Ok. 

c. Klik icon Revolve Boss/Base pada toolbar feature, pilih front. 

d. Mulai membuat sketch seperti pada gambar dibawah. Gunakan Line dan 

Center Line untuk membuat garis dan Smart Dimension untuk menarik 

ukuran. Klik pada center line untuk menarik ukuran dalam diameter. 

Catatan: pastikan membuat sketch tertutup dengan tidak ada garis (line) yang tidak 

tersambung. 
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2. Menggunakan Feature Revolve : 

a. Keluar  dari  sketch  (    ) yang telah dibuat sebelumnya, atau bisa 

langsung menuju pada feature revolve. Command Manager > Features > 

Revolve Boss/Base. Maka akan muncul panel pada sebelah kiri seperti pada 

gambar. 

Line7 adalah objek pada sketch yang 

digunakan sebagai garis tengah atau 

sumbu putar yang biasanya 

menggunakan garis putus-putus (center 

line). 

 

 

 

 

 

 

 

b. Lalu klik Ok. 
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3. Menggunakan Fillet. 

a. Pada part yang telah dibuat sebelumnya, feature fillet bisa langsung 

digunakan tanpa menerapkan sketch. Pada Command Manager > Features 

> Fillet ( ). 

b. Klik pada sudut luar atas part, dan beri ukuran (radius) kelengkungan 

sebesar 3mm. 

 

 

4. Menggunakan Feature Revolve Cut. 

a. Pilih Right Plane, klik Sketch, pilih View Normal To. Lalu dengan Line 

gambar sesuai dengan gambar dibawah 
 

b. Menggunakan feature revolve cut. Command Manager > Features > 

Revolve Cut. Pilih garis dengan panjang 28 mm sebagai sumbu putar (axis 

of revolution) dengan putaran 360 derajat. 
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c. Klik Ok. 
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BAB III 

FEATURE SWEEP & FEATURE CURVES 

 
Curve digunakan untuk membuat alur gambar yang berbentuk curva 

seperti halnya membuat pegas, baut dan sebagainya. Karena dalam SolidWorks 

pembuatan bentuk melingkar dan mengular tidak bisa tanpa menggunakan Curve. 

Langkah pertama Kita akan mencoba membuat Pegas Sederhana. 

 

 

Berikut ini adalah langkah-langkah untuk membuat pegas seperti di bawah ini: 

1. Klik New ( File > New ), klik Part  , OK. 

Sebelum mulai menggambar kita akan mengubah standar ukuran yaitu, 

Klik 

2. Option        (Tools  > Option…),  pilih Document  Properties tab. Pilih 

Units, pada Unit System pilih IPS (Inch, pound, second), OK. 

3. Klik Pada Top Plane lalu klik sketch 
 

 

4. Klik Circle (lingkaran ), Klik titik origin  sebagai titik awal, geser 

kursor ke sebelah kanan sampai membentuk sebuah lingkaran. Klik 
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sembarang titik untuk mengakhiri. Kemudian Klik Smart Dimension dan 

isikan ukuran yang diinginkan dalam contoh ini diameter lingkaran adalah 

0.50 inchi. 
 

 

 
5. Ubah pandangan gambar menjadi Isometric View. 

 

6. Klik Features , kemudian klik Curves dan pilih Helix And Spiral. 
 

Pilih Pitch and Revolution pada kotak perintah 

Defined By. Kemudian Pada bagian 

Parameters klik Constant Pitch. Untuk 

menentukan tinggi pegas isikan pada kotak 

Pitch nilai 0,10 inchi dan untuk menentukan 

jumlah alur yang diinginkan isikan pada kotak 

Revolutions nilai 4, serta Start Angle bernilai 

0,0 deg . kemudian klik Ok atau Centang. 
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7. Pilih Right Plane, kemudian pilih view Normal To. 

8. Klik Sketch kemudian klik Circle. 

9. Gambar lingkaran dengan titik pusat seperti terlihat pada 

gambar di bawah ini. Klik Smart Dimension untuk  

memberi ukuran lingkaran ini dengan diameter 0,05 inchi. 

 

 

 
10. Klik Exit Sketch. 

11. Klik Features , kemudian klik Sweept Boss/Base . 
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12. Kemudian pada Property Manager kita pilih sketch 2 sebagai gambar 

utama (profile) dan sketch 1 (helix/spiral ) sebagai Patch, seperti gambar 

berikut: 

 

13. Kemudian klik Ok atau Centang  Untuk melihat hasilnya bisa kita ubah 

menjadi pandangan Isometric. 

 

Setelah berhasil membuat pegas dengan solidworks selanjutnya kita akan 

mencoba berlatih membuat baut (Nut) menggunakan solidworks. Dalam 

Pembuatannya juga menggunakan curve serta sweept cut dan feature yang lainnya. 

Berikut ini adalah langkah-langkah untuk membuat baut seperti di bawah ini: 

 
1. Klik New ( File > New ), klik Part , OK. 

2. Klik Pada Right Plane lalu klik sketch 
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3. Selanjutnya pilih Polygon , bentuk sebuah Polygon segi enam dengan 

ukuran sembarang yang ber pusat pada titik Origin dan berikan ukuran pada 

lingkaran polygon sebesar 20 mm. 

 

 
4. Lalu klik features, kemudian klik Extrude Boss/Base dengan ukuran depth 

sebesar 10 mm. 

5. Setelah b e r b e n t u k s o l i d , kemudian k l i k p e r m u k a a n d e p a n 

d a r i p r o f i l segi enam tersebut lalu klik sketch. 

 

 
6. Buat lingkaran yang berpusat di pusat segi enam. beri ukuran diameter 

lingkaran sebesar 18 mm, kemudian masuk feature , klik extrude bos/Base 

dengan ketebalan 1 mm. 
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7. Langkah selanjutnya kita buat lingkaran pada  permukaan  lingkaran 

yang telah kita buat. dengan memberi ukuran diameter lingkaran 14 mm. 

 
Kemudian masuk feature dan klik Extrude bose/Base dengan ketebalan 30 

mm. 

8. Setelah selesai extrude , klik Chamfer 
 

Dan kita lanjutkan seperti gambar di bawah ini . Masukkan ukuran 

champer 1.00 mm dan kemudian klik ok. 
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9. Klik menu Helix and Spiral pada menu bar. 

 

 

Kemudian klik permukaan lingkaran bawah baut sehingga pada panel tree 

akan muncul sebuah Sketch baru.lalu buat lingkaran yang sepusat dengan 

lingkaran bawah baut dan beri ukuran 14 mm. 

 

Setelah selesai klik Exit Sketch sehingga akan muncul bentuk spiral pada 

baut. 

10. Pada panel Helix & Spiral masukkan data sebagai berikut : 

Devined By : Height and Pitch 

Constant Pitch ( pitch tidak berubah sepanjang pegas ) 

Heigth : 27 mm 
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Pitch : 2.5 mm 

Start Angle 0 

Centang pada reverse direction Counterclockwise (berputar berlawanan 

arah dengan arah jarum jam) Kemudian tekan Enter atau ok. 

11. Pada Panel Tree, klik Top Plane dan klik Sketch, dalam sketch tersebut 

kita akan membuat sebuah segitiga dengan menggunakan Polygon sebagai 

bentuk/profil ulir pada ujung spiral yang sebelumnya telah dibuat dengan 

ukuran segitiga sebesar 1.60 mm seperti gambar di bawah ini. Kemudian 

klik Exit Sketch. 
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12. Selanjutnya masuk Feature > Sweept Cut, kemudian untuk kolom profil 

klik Segi tiga , dan untuk kolom patch klik profil Spiral dan tekan enter 

atau ok. 

 

13. Untuk tahap terakhir, buat sketch baru pada permukaan segi enam pada 

atas baut, kemudian buat sebuah lingkaran dengan ukuran sama besar 

dengan polygon. 
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14. Klik Feature > Extrude Cut, pada panel beri centang pada pilihan Flip 

Side To Cut dan aktifkan pilihan Draft yang diberi angka 60 derajat. 

 

 
 

Jika sudah selesai kemudian enter atau Ok. 

15. Selesai , maka hasil akhir dari pekerjaan anda adalah seperti ini: 
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BAB IV 

HELICAL GEAR 

 

 
A. Membuat Sketch 

1. Klik New, lalu klik Part, klik OK 

2. Klik Front Plane dan Klik Sketch 
 

3. Klik Circle, dan buatlah sketch pada sumbu utama (origin). Klik Smart 

4. Dimension, klik lingkarannya dan aturlah diameternya sebesar 1.0 in 
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B. Melakukan Extruded Boss/Base 

1. Klik Features, lalu Extruded Boss/Base dan aturlah D1 0.30 in, klik OK 
 

2. Klik pada sisi depan dan pilih Normal To. 
 

3. Klik pada sisi depan dan pilih Sketch. 
 

4. Klik pada Centerline (sumbu) dan buatlah sket garis vertical. 
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5. Klik Line ( ) dan buatlah sket profil gear. 
 

6. Klik Smart Dimension ( ), atur ukurannya seperti pada gambar di 

bawah ini. 

 

7. Klik Exit Sketch ( ) dan ubahlah pandangan menjadi Isometric. 
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8. Klik scroll mouse button dan putarlah ke sisi yang sebaliknya. 
 

9. Klik sisi belakang dan pilihlah Normal To. Klik sekali lagi pada sisi ini dan 

pilihlah Sketch. 

 

10. Selanjutnya tekan CTRL dan sambil klik semua garis profil gearnya. 
 

11. Klik Convert Entities ( ). Untuk menghilangkan hubungan sketh 

antar kedua sisi, maka kliklah Display/Delete 

 

 

Relations ( ) dan klik Delete All. 
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12. Klik dan drag semua garis sketchnya. 
 

13. Selanjutnya Klik pada Rotate Entities, 
 

14. Klik Center of rotation box 
 

15. Dan klik origin (center part). 
 

16. Pada pilihan parameter, atur angka sebesar 10 derajat rotasi. Lalu klik OK 
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17. Klik   Exit  Sketch  ( ) kemudian ubahlah pandangan menjadi 

Isometric. 
 

 
C. Melakukan Lofted Boss/Base 

1. Klik Features, lalu pilih Lofted Boos/Base. 
 

2. Klik kedua sudut pada masing-masing profil gear, klik OK  

 

 
D. Membuat Penggandaan Feature dengan Pattern 

1. Klik Circular Pattern. 
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2. Kemudian klik sisi lingkarannya 
 

3. Atur jumlahnya sebesar 22 dan OK . 

 

 
E. Melubangi Objek dengan Exrtruded Cut 

1. Klik pada sisi depan dan pilihlah Normal To. 
 

2. Klik lagi sisi depan dan pilih Sketch. 
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3. Buatlah sketh Circle ( ) pada pusat lingkaran. Klik Smart 

Dimension ( ), dan atur ukurannya 0.40 in. 
 

4. Klik Features, lalu pilih Extruded Cut ( ) dan atur Direction pada 

Through All kemudian OK . 

 

5. Klik sisi depan dan pilih Sketch 
 

6. Klik Rectangle, pilih Center Rectangle dan buatlah sketch dengan ukuran 

seperti pada gambar di bawah. 
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7. Klik Features, lalu Extruded Cut ( ) dan atur Direction ke dalam 

Through All. 

8. Klik OK . 
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BAB V 

PERAKITAN KOMPONEN (ASSSEMBLY) 

 
Solidworks tidak hanya digunakan untuk merancang dan menggambar 

sebuah komponen/part, namun salah satu kelebihannya adalah anda dapat merakit 

beberapa komponen menjadi sebuah benda / peralatan baru. 

Pada bagian ini anda akan belajar merakit bracket sederhana yang terdiri 

dari 6 buah komponen. Dan komponen tersebut telah di siapkan oleh kami, anda 

tinggal membukanya pada assembly. 

 

MERAKIT SLIDER MEKANIS 
 

A. Pola pembuatan perakitan (Assembly) di dalam SolidWorks 

Secara umum, proses perakitan (assembly) pada SolidWorks dimulai dengan: 

1. Memilih part (insert component) 

2. Memasangkan part tersebut (mate) 

 Coincident 

 Concentric 

 Perpendicular 

 Parallel 

 Tangent 

3. Menguji mate/constraint yang sudah di buat. 

 Rotate component  Move component 

Dalam tutorial ini akan dijelaskan proses Assembly step by step dari beberapa 

part sederhana, didalam merakit “Slider Mekanis” ini, kita akan membutuhkan 

4 part yaitu: 
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1. Base 
 

2. Block 
 

3. Connecting Rod (Conrod) 
 

4. Crank Shaft (Crank) 
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B. Langkah-langkah membuat Part Slider Mekanis. 

Part pertama: Base 

Langkah-langkahnya dalam pembuatan part pertama adalah: 

 

1. Open SolidWork, 

2. Klik New, pilih Part, kemudian klik OK 

3. Klik Sketch, pilih Top Plane, klik Rectangle 

4. Buat persegi panjang ukuran 10 x 100, gunakan Smart Dimension untuk 

mendapat ukuran yang di inginkan 

5. Exit Skecth, klik Feature, pilih Extruded Boss/Base (akan muncul 

Extruded property manager). 

6. Isikan 10 mm ke dalam kolom Depth. 
 

7. Buat pin di salah satu sisi memanjang dari part tersebut, klik Extruded 

Boss/Base, kemudian pilih salah satu Plane pada part tersebut. 

8. Klik Circle, masukkan Radius = 2.5 dalam kolom radius di property 

manager 

9. Klik OK. 
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10. Klik view Normal To, klik Smart Dimension, kemudian letakkan Circle 

tepat ditengah- tengah dengan jarak part. 
 

11. Klik OK, klik Exit Sketch (akan keluar Extuded property manager ) 

12. Di dalam kolom Depth masukkan angka 5 mm, lalu klik OK. 

13. Pilih view Isometric. 

14. Simpan part yang telah jadi dengan nama “Base” 

 

Part Kedua: Block 

Langkah-langkahnya dalam pembuatan kedua adalah: 

1. Klik New, pilih Part, lalu klik OK 

2. Klik Sketch, pilih Top Plane, klik Rectangle 
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3. Buat kotak ukuran 10 x 10, gunakan Smart Dimension untuk mendapat 

ukuran yang diinginkan. 

4. Exit Skecth, klik Feature, pilih Extruded Boss/Base (akan keluar 

Extruded property manager). 

5. Isikan 10 mm ke dalam kolom Depth. 
 

6. Buat pin di salah satu sisi memanjang dari part tersebut, klik Extruded 

Boss/Base, pilih salah satu Plane pada part tersebut. 

7. Klik Circle, masukkan Radius = 2.5 mm dalam kolom radius di property 

manager, lalu klik OK. 
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8. Pilh view Normal To, klik Smart Dimension, letakkan Circle tepat di 

tengah-tengah dengan jarak masing-masing 5 mm dari tepi. Atau cari titik 

tengahnya agar lebih mudah. 

9. Klik OK, klik Exit Sketch (akan muncul Extuded property manager) 

10. Di dalam kolom Depth masukkan 10 mm, klik OK. 
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11. Pilih view Isometric. 
 

12. Simpan part yang telah jadi dengan nama “Block” 

 
Part ke tiga: Connecting Rod (Conrod) 

Langkah-langkahnya dalam pembuatan part ketiga adalah: 

1. Klik New, pilih Part, klik OK 

2. Klik Sketch, pilih Front Plane, klik Circle 

3. Buat 2 lingkaran sejajar dengan jari-jari 5 mm, gunakan Smart Dimension 

buat jarak antar lingkaran sebesar 60 mm. 
 

4. Buat 2 garis penghubung 2 lingkaran tersebut. 
 

5. Trim sisi dalam lingkaran tersebut, pilih tools, kemudian Trim, trim to 

closest (arahkan pointer ke garis di sisi dalam lingkaran tersebut hingga 

berubah warna merah). 
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6. Klik OK, lalu pilih Features, selanjutnya pilih Extruded Boss/Base 

7. Di dalam Extrude property manager, masukkan 5 mm di dalam kolom 

Depth, klik OK untuk keluar. 
 

8. Klik Extruded Cut, pilih Plane di sebelah atas part. 
 

9. Pilih Plane Normal To, Klik Circle. 

10. Masukkan nilai 2.5 mm di dalam kolom Radius. 
 

11. Pilih Plane Isometric, Exit Sketch (akan keluar property manager). 
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12. Masukkan nilai 5 mm di dalam kolom Depth, Klik OK untuk keluar. 

13. Klik Extruded Boss/Base. 
 

14. Pilih Plane Normal To, Klik Circle. 

15. Buat lingkaran sejajar dengan lingkaran pertama. 

16. Masukan nilai 2,5 mm pada kolom Radius. 
 

17. Klik OK. 

18. Pilih View Isometric, Exit Sketch (akan muncul Extrude property 

manager). 

19. Masukkan nilai 5 mm pada kolom Depth. 
 

20. Save part yang telah jadi dengan nama Conrod. 
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Part ke empat: Crank Shaft (Crank). 

Langkah-langkahnya dalam pembuatan part keempat sebagai berikut: 

1. klik New, pilih Part, klik OK. 

2. Klik Sketch, pilih Front Plane, klik Circle. 

3. Buat 2 lingkaran sejajar dengan jari-jari 5 mm, gunakan Smart Dimension 

Buat jarak 40 mm. 
 

4. Buat garis penghubung 2 lingkaran tersebut. 
 

5. Trim sisi dalam 2 lingkaran tersebut, pilih tools, klik sketch tools, klik 

trim, pilih trim to closest, arahkan pointer pada garis di sisi dalam 

lingkaran tersebut hingga berubah warna merah. 

 

6. Klik OK, sselanjutnya pilih Features, pilih Extrude Boss/Base. 

7. Di dalam Extrude property manager, masukkan 5 mm di dalam kolom 

Depth. 

8. Klik OK untuk keluar. 
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9. Klik Extruded Cut pilih Plane di sebelah atas part. 

10. Pilih Plane Normal To, klik Circle. 

11. Masukkan nilai 2.5 mm di dalam kolom radius. 
 

12. Buat lingkaran dengan jari-jari 2.5 mm pada jarak 40 mm. 
 

13. Pilih Plane Isometric, Exit Sketch (akan keluar property manager). 

14. Masukkan nilai 5 mm di dalam kolom Depth, Klik OK untuk keluar. 
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15. Save part yang telah jadi dengan nama “Crankshaft”. 

 
Setelah ke 4 part tersebut jadi, langkah selanjutnya adalah menggabungkan part- 

part tersebut. 

 

Menggabungkan antara Base dengan Block (Mate). 

1. Buka SolidWorks, klik New, pilih assembly, klik OK 

2. Akan keluar Insert Component property manager > klik Browse > pilih 

part (Base) > open. 
 

3. Secara default, Part pertama akan di tandai sebagai fix part, part selanjutnya 

akan di tandai sebagi Float Part. 

4. Klik Insert Component di Assembly toolbar, klik Browse di Insert 

Component property manager, pilih part Block, Open. 
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5. Klik Mate di assembly toolbar (akan keluar Mate property 

manager) 

 

6. Pada Standard Mates, pilih Coincident, 

7. Pada Mate selection, pilih plane pada bagian atas Base dan plane pada 

bagian bawah Block, klik OK untuk keluar. 
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8. Pada  kolom Mate di Mate property manager akan Nampak 

Mate yang telah kita ubah sebelumnya. 
 

9. Kita akan mendefinikan Mate kedua, klik Coincident pada kolom Standard 

Mates, pada Mate Selection, pilih kedua sisi pada Base dan Block yang 

berhadap-hadapan, seperti pada gambar di bawah. 

 

10. Klik OK, klik OK untuk keluar dari Mate property manager. 

11. Print screen dari mate pertama = coincident1 
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12. Print screen dari mate kedua = coincident2 
 

13. Kita akan mengecek gerak dari part Block, klik Move Component akan 

keluar Move Component property manager, pilih component dan drag 

untuk menggerakkannya, pilih Block. 

 

14. Kita akan melihat Block hanya dapat bergerak lurus segaris dengan 

bidang atas dari Base. 
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C. Menggabungkan masing-masing part. 

Menggabungkan antara part Base dan part Crank. 

1. Putar View dengan Rotate View, hingga Nampak seperti gambar 
 

2. Klik Insert Component, insert component property manager akan 

muncul. 

3. Klik Browse, pilih Crank , klik Open, lalu tempatkan Crank di sebelah 

kanan dari assembly yang telah di bentuk. 

 

4. Klik Mate, kemudian pada Standard Mates pilih Concentric (kolom 

Mate Selections akan aktif), lalu pilih pin pada Base. 
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5. Pada mate selectiions yang kedua pilih lubang pada Crank. 
 

6. Klik Ok. 
 

7. Pada Standard Mates yang kedua pilih Coincident, pada mate selections 

yang pertama pilih bidang sisi dalam dari Base. 
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8. Putar view dengan Rotate View, sehingga sisi Crank  yang  menghadap  

ke Base nampak, untuk mate selections yang kedua pilih bidang ini. 

 

9. Klik OK untuk keluar dari Mate property manager, putar assembly sekali 

lagi dengan Rotate view, klik Rotate components, pilih Crank lalu drag 

component untuk mencoba hasil Mate terakhir tadi. 

Menggabungkan part connecting rod dengan assembly. 

1. Klik Insert component, pilih Insert component property manager akan 

muncul. 

2. Klik Browse, pilih Conrod, klik Open lalu  tempatkan  Conrod  di  

sebelah kanan dari assembly yang telah dibentuk. 
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3. Klik Rotate Component putar Conrod hingga pin pada Conrod menghadap 

lubang pada Crank, klik Ok untuk keluar dari Rotate Component 

Property Manager. 

 

4. Klik Mate, selanjutnya pada Standard Mates pilih Concentric (kolom Mate 

Selections akan aktif), pilih lubang pada Crank. 

 

5. Pada mate selection. 
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6. PadaStandard Mates yang kedua kita pilih Coincident, pada Mate 

Selections yang pertama pilh bidang sisi luar dari Crank. 

 

7. Putar view dengan Rotate View, sehingga sisi Conrod yang menghadap 

ke Base nampak. (untuk mate selections yang kedua pilih bidang ini). 

 

8. Klik Ok. 
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9. Putar view dengan Rotate View sekali lagi. 
 

10. Buat mate yang terakhir untuk menggabungkan pin di block dengan lubang 

di Conrod pada feature Standard Mates (assembly features), klik 

Concentric pada mate selection yang pertama pilih pun pada Block. 

 

11. Pada mate selection yang kedua pilih lubang pada Conrod. 
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12. Klik Ok. 
 

13. Klik OK untuk keluar dari Mate property manager, proses perakitan telah 

selesai. 

14. Klik Rotate Component pilih Crank, Drag Crank tersebut. 
 

15. Selesai. 
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D. Simulasi dari Perakitan Slider Mekanis 

 
Setelah kita selesai membuat sebuah “Assembly” di SolidWorks, kita dapat 

melakukan simulasi dari assembly tersebut. Ada 4 macam simulasi di 

SolidWorks: 

1. Rotary Motor 

2. Linear Motor 

3. Linear Spring 

4. Gravity 

Kita akan mempelajari simulasi Rotary Motor dari assembly “Slider Mekanis”. 

 
E. Langkah kerja Simulasi dari Perakitan Slider Mekanis. 

 
1. Buka SolidWorks, klik Open, pilih file assembly yang akan di buat 

simulasi geraknya (contoh: slider mekanis), klik open. 

2. Klik toolbar Simulation (klik Insert, klik simulation). 
 

3. Terdapat 4 pilihan : Linear motor, Rotary motor, Linear spring dan 

Gravity, pada assembly ini kita akan menggunakan Simulasi “Rotary 

motor”, klik Rotary motor (Rotary motor property manager akan muncul 

di sebelah kiri). 
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4. Pada kolom Direction Reference, pilih Crank, klik sisi luar dari Crank. 
 

 
5. Klik tombol Reverse Direction jika arah putaran yang kita kehendaki 

berbeda. 

 

6. Atur kecepatan dengan menggeser tombol di sebelah bawah dari direction 

reference. Geser ke kiri untuk kecepatan yang lebih rendah atau sebaliknya. 
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7. Pada SolidWorks dengan release yang lebih baru, kita bisa memasukkan 

kecepatan secara manual, misal 2.3 derajat/detik. 

8. Klik Ok untuk keluar dari Rotary motor propert manager, di 

FeatureManager design tree akan keluar Simulation dengan 

RotaryMotor1. 

 

9. Klik Simulation, klik Calculate Simulation. 
 

10. SolidWorks akan menghitung simulasi yang telah kita tentukan 

sebelumnya, klik Stop Record or Playback.Record or Playback untuk 

keluar dari Calculate Simulation. 
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11. Klik Replay Simulation. 
 

12. Akan keluar jendela “animation controller”. 
 

13. Di dalam jendela “animation controller” ini terdapat tombol Start; 

Rewind; Play; Fast Forward; End; Pause; Stop; Save; Normal; Loop; 

Reciprocate; Slow Play; Fast Play. 

14. Klik Play untuk melihat Simulasi gerak dengan Rotary Motor. 

15. Klik Save untuk menyimpan dalam bentuk video dengan format AVI. 

16. Selesai. 
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BAB VI 

EXPLODED VIEW & DRAWING ASSEMBLY 
 

 

 
Pada bab ini kita akan mempelajari tentang explode view, animasi dalam 

assembly dan pembuatan drawing assembly. 

Latihan 

Rakitlah beberapa file yang diberikan tentor hingga menjadi gambar seperti berikut 
 

Berikut beberapa langkah dalam pembelajaran ini: 

1. Open file. Dengan gambar seperti gambar diatas. ( latihan pada bab 

sebelumnya ). 
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2. Pertama kita akan belajar explode 

view assembly. Klik Assembly > 

Explode View, lalu akan muncul 

menu explode. 

 

 

 

3. Kemudian kita klik salah satu part, akan muncul sumbu 3 arah.dengan sumbu 

tersebut kita dapat menggeser part menjadi explode view 

 

Lakukan hal tersebut ke part lain..sehingga menghasilkan explode view. 
 

Setelah selesai bisa centang atau ok. 

Drawing Assembly 

1. Langsung saja klik file > make drawing from part/assembly. 
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2. Pada sheet format/size pilih A4-Landscape, lalu OK. 
 

3. Langsung saja tarik pandangan isometric ke dalam kertas gambar. 
 

4. Kemudian kita ubah tampilan gambar hingga seperti berikut, dengan skala 1:2 
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5. Klik annotation > table dan pilih bill of material. 
 

Kemudian klik gambar nya ,lalu akan muncul panel properti nya, lalu klik OK. 

6. Akan muncukl tabel bill of material . apabila ada yang kurang, dapat di edit, dengan 

cara klik kanan pada tabel bill material. Maka akan menjadi gambar seperti ini. 

7. Masukkan gambar dengan pandangan atas dan kanan.dengan cara model view. 
 

8. Kemudian kita akan membuat alternatif position dengan cara pada pandangan 

kanan klik kanan > drawing view> alternative position .maka akan muncul panel 

properti.langsung enter dan akan masuk kedrawing seperti berikut, dan langsung 

geser bentuk i=hingga seperti berikut dan enter. 
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Setelah enter akan masu ke menu drawing kembali dan akan menjadi seperti ini 

gambarnya. 

 

Lalu save ke pdf, sebelum di save anda dapat mengedit sheet formatnya terlebih 

dahulu.
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 BAB VII 

PENGGUNAAN TOOLBOX 

 

A. Membuat Part 

Langkah awal membuat Part seperti pada gambar dibawah ini, lalu simpan (save) 

pada directory yang telah ditentukan: 

Part 1 
 

Gambar 1. Base Plate 
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Part 2 

 

 

 

 

Gambar 2. Mounting 

 

Part 3 
 

Gambar 3. Buhsing 
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Part 4 

 

 

 

 

Gambar 4. Roller 

 
B. Menggabungkan seluruh Part yang telah dibuat sebelumnya (Assembly). 

1. Buka SolidWorks, klik New, pilih Assembly, lalu klik Ok. 

2. Pada Command Manager, pilih Assembly Tab, klik Insert Component, lalu 

Browse, pilih Part1 > Open. 
 

3. Selanjutnya membuka Part2 seperti yang dilakukan pada langkah sebelumnya, 

pada Insert Component, klik Browse lalu pilih Part2 > Open. (Sebanyak dua 

part). 
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4. Klik Mate ( ) pada assembly toolbar (maka akan muncul Mate Property 

Manager). 

5. Pilih Standard Mates > Coincident. (Secara otomatis akan diarahkan pada 

Mate Selection). 

6. Pada Mate Selection, pilih garis sudut dalam pada Part1 dan garis sudut bawah 

pada Part2, klik Ok. 

 

7. Selanjutnya mendefinisikan Mate yang kedua, klik Coincident pada kolom 

Standart Mates. Pilih sisi atas lubang pada Part1 dan sisi bawah lubang pada 

Part2, klik Ok. 
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8. Selanjutnya untuk menggabungkan Part2 yang kedua, pilih Coincident. Pada 

Mate Selection, pilih garis sudut dalam pada Part1 dan garis sudut bawah pada 

Part2, kemudian klik Flip Mate Alignment (  ) untuk memutar balik hadap 

Part2 yang kedua, lalu klik Ok. 
 

9. Mate kedua, klik Coincident pada kolom Standard Mates. Pilih sisi atas lubang 

pada Part1 dan sisi bawah lubang pada Part2, klik Ok. 
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10. Klik Ok ( ), untuk keluar dari Mate Property Manager. 

11. Klik Insert Component pada assembly toolbar, klik Browse kemudian pilih 

Part3 > Open (sebanyak dua part). 
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12. Klik Insert Componen pada assembly toolbar, klik Browse kemudian pilih 

Part4 > Open. 
 

13. Klik  Mate (   ) pada assembly tollbar (akan muncul Mate property 

manager). 

14. Pilih Standart Mates, pilih Concentric. 

15. Pada Mate Selection, pilih permukaan dalam pada lubang Part2 dan permukaan 

lingkaran luar pada Part3 yang pertama, klik Ok. 

 

16. Mate kedua, klik Coincident pada kolom Standart Mates. Pilih kedua sisi 

pada Part2 dan Part3 yang saling berhadapan, klik Ok. 
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17. Selanjutnya untuk menggabungkan Part3 yang kedua, pilih Concentric. 

18. Pada Mate Selection, pilih permukaan dalam pada lubang Part2 dan permukaan 

lingkaran luar pada Part3 yang kedua, klik Ok. 
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19. Mate kedua, klik Coincident pada kolom Standart Mates. Pilih kedua sisi pada 

Part2 dan Part3 yang saling berhadapan, klik Ok. 
 

20. Selanjutnya menggabungkan Part4, klik Coincident pada kolom Standart 

Mates. Pilih garis lubang bagian dalam pada Part3 dan garis lubang pada Part4, 

kemudian klik Flip Mate Alignment (   ) untuk memutar balik Part4, klik 

Ok. 
 

21. Klik Ok, untuk keluar dari Mate Property Manager. 
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C. Menggunakan Toolbox. 

Sebelum memberi kelengakapan pada Part yang sudah di Assembly, hal selanjutnya 

yang dilakukan adalah memunculkan Toolbox. Pada View Palette sebelah kanan, 

pilih tab Design Library, klik Toolbox, lalu klik pada tulisan Add in Now. 

 

1. Memberi baut (bolt). 

a. Setelah Toolbox dibuka, selanjutnya mengambil peralatan (sudah jadi) di 

library yang akan digunakan pada part assembly. 

b. Pada Toolbox, pilih ISO > Bolts and Screws > Hex Bolts and Screws > 

Hex Flange Bolt ISO 4612. Drag & drop pada drawing area. 

c. Pada configuration component, isi properties dengan M6 (ukuran headbolt 

/ kepala baut), dan Length (Panjang baut) 12 mm. Klik Ok. 
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d. Tempatkan baut pada part assembly. 
 

e. Menambahkan baut (bolt) yang selanjutnya, klik tab Design Library > 

Toolbox > ISO > Bolts and Screws > Hex Bolts and Screws > Hex Bolts 

and Screws Grade AB ISO 4014. Drag & drop pada drawing area. 
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f. Pada configuration component, isi properties dengan M6 (ukuran headbolt 

/ kepala baut), dan Length (Panjang baut) 45 mm. Klik Ok. 

g. Tempatkan baut pada part assembly. 
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2. Memberi mur (nut). 

Selanjutnya pemberian mur (nut) pada part assembly, cara pengambilan mur 

sama seperti langkah-langkah mengambil baut sebelumnya. Yaitu dengan: 

a. Klik Design Library, pilih Toolbox > ISO > Nuts > Hex Nuts > Hex Nuts 

Grade C ISO – 4034. Drag & drop pada drawing area. 

b. Pada configuration component, isi properties dengan M6 (ukuran headbolt 

/ kepala baut), dan Length (Panjang baut) 45 mm. Klik Ok. 
 

c. Letakkan mur pada part assembly. 
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BAB VIII 

MATERIAL DAN ANALYSIS 

SolidWorks tidak hanya digunakan untuk merancang atau menggambar 

benda namun dalam suatu perancangan kita harus mengetahui massa benda kita dan 

dapat memperhitungkan tegangan-tegangan yang akan terjadi sehingga kita dapat 

mengetahui apakah komponen tersebut yang kita rancang baik atau tidak. 

Sehingga dalam SolidWorks hal tersebut dapat kita pelajari. Dengan 

tambahan informasi material, material ini yang telah disediakan oleh SolidWorks, 

sehinggga dapat membantu menjalankan aplikasi ini. Berikut ini adalah tahap- 

tahap dalam mempelajari Massa material dan analisys: 

 Kita akan membuat sebuah balok sederhana. Klik new, klik part, lalu ok. 

 Klik front plane ,lalu buat sketsa seperti berikut menggunakan front plane. 
 

 Klik feature > extrude boss/base, lalu kita beri ketebalan 150 mm, lalu 

enter atau ok. dan akan mejadikan gambar solid seperti berikut: 
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A. Menghitung massa benda 

Dari part yang telah kita buat. Langsung saja tanpa dikeluarkan kita ketahap 

menghitung massa benda 

1. Kita akan memberi jenis material untuk benda tersebut. Klik kanan material 

pada Panel Tree. lalu klik edit material. 

 

Selanjutnya memilih material , pilih alumunium 6061 alloy. Kemudian apply 

dan close. 
 

2. Klik menu Evalute > mass properties. 
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Maka akan muncul panel mass properties dari part yang telah anda buat. 
 

Dari panel tersebut anda bisa mendapatkan massa dari part yang telah anda 

buat yaitu 162 gram. 

B. Analisys Tegangan 

Dari part yang telah kita buat. Langsung saja tanpa dikeluarkan kita ke tahap 

Analisys tagangan benda tersebut. 

1. Klik Evalute kemudian klik Simulation Expres Analisys Wizard, maka akan 

muncul menu analisys dan langsung saja di next. 
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2. Kemudian pilih add feature. Kemudian kita pilih face yang di depan. 
 

Klik OK. kemudian kita next 

3. Klik add force. Lalu pilih sisi atas 
 

Masukkan besar gaya yang diterima benda. sebesar 1200 N. Kemudian ok 

dan pilih next 

4. Untuk material karena dari pertama adalah allumunium 6061 alloy, maka 

langsung kita next. 

5. Kemudian kita run simulation, dan akan muncul hasil simulasinya. 
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2 

 

Langkah pembuatan partnya 

1. gambar part dengan font plane , kemudian di revolve 
 

2. Gambar bodi kedua dengan right plane dan straight slot , lalu di revolve 
 

Sehingga akan berbentuk sebagai berikut : 
 

3. Kemudian buat bentuk sweep dengan sketsa sebagai berikut 
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Kemudian di circular pattern menjadi bentuk seperti berikut 
 

Kemudian di fillet 3 mm pada bagian sweep 

Dan chamfer 4 mm x 2 mm pada bagian bentuk silinder dalam 
 

4. Buat sketch pada bagian atas seperti berikut , kemudian kita extrude kearah 

atas sebesar 6 mm ,dan ke bawah diganti menjadi up to next 
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5. Kemudian pada tempat setalah extrude kita beri lubang dengan diameter 9 mm. 
 

Kemudian kita fillet 1 mm pada bagian sambungan 
 

6. Terus kita beri lubang pada titik tengah bagian bawah gambar mengunakan 

extrude cut dengan kedalaman 12.7 mm 
 

dan gambar telah selesai.
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